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Hoofdstuk 3

Project management

3.1 Definities

Ontwerpprojecten en projecten in het algemeen worden meestal gëımplementeerd
om het strategisch plan van een organisatie te verwezenlijken. Volgende ken-
merken zijn onderscheidend voor ’projecten’ (in tegenstelling tot het begrip
’operaties’) :

• Ze worden uitgevoerd door mensen.

• Ze zijn beperkt door gelimiteerde resources.

• Ze worden gepland, uitgevoerd en gecontroleerd.

• Projecten vereisen het ontwikkelen van iets nieuws (uniek).

• Een progressieve uitwerking.

Projectmanagement is het toepassen van kennis, vaardigheden, hulpmid-
delen en technieken op projectactiviteiten om de projecteisen te volbrengen.
Projectmanagement wordt uitgevoerd m.b.v. processen als: initiëring, plan-
ning, uitvoering, controleren en afsluiten. Het is belangrijk op te merken dat
veel van de processen in het projectmanagement van nature iteratief zijn:
hoe meer geweten is rond een project hoe beter het kan geleid worden.

Toepassingsgebieden zijn categorieën van projecten die gemeenschappe-
lijke elementen hebben. Deze kunnen gedefinieerd worden in functie van:

• Functionele departementen (juridisch, productie, marketing, personeel,
logistiek).

• Technische elementen (software, pharmacie, bouw, etc.).
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58 HOOFDSTUK 3. PROJECT MANAGEMENT

• Management specialisaties (overheidscontracten, gemeenschapsontwikke-
lingen, nieuwe productontwikkeling).

• Industrie groepen (automobielsector, chemische nijverheid, etc.).

Het project is gerelateerd tot andere types van activiteiten: een ’pro-
gramma’ is een groep van projecten die op een gecoördineerde manier geleid
worden om voordelen te bekomen die niet bereikt kunnen worden door de
individuele project management. Projecten worden geregeld opgedeeld in
’deelprojecten’ die gemakkelijker te leiden zijn. Deze deelprojecten worden
vaak uitbesteed aan externe bedrijven of aan een ander functionele eenheid
in het bedrijf. ’Project portofolio management’ duidt de selectie en onder-
steuning van project- of programmainvesteringen aan. Deze investeringen
zijn ingegeven door het strategisch plan van het bedrijf en de beschikbare
resources.

Een project bestaat uit een reeks gëınterlinkte processen (waarbij een
’proces’ een reeks akties is die een resultaat bewerkstelligen). Deze processen
worden uitgevoerd door mensen en kunnen onderverdeeld worden in twee
categorieën:

• Project management processen (ze beschrijven, organiseren en ver-
volledigen het werk van een project).

• Product-georiënteerde processen die het product van het project specifiëren
en creëren.

Project management processen kunnen gecatalogeerd worden in vijf groepen,
die verdeeld zijn binnen een fase en interageren tussen de fasen van het project
(zie Figuren 3.1 en 3.2):

• Initiërende processen (autorisatie)

• Planning processen (definiëren en verfijnen van objectieven en selecteren
van alternatieven).

• Uitvoerende processen(coördinatie van resources).

• Controle processen (verzekeren dat de objectieven beoogt worden).

• Afsluitende processen (formaliseren van het aanvaarden van het project
of een fase)
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Figuur 3.1: Verdeling van de verschillende proces groepen tijdens een fase
het project.
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Figuur 3.2: Interactie van de verschillende processen tijdens het project.

3.2 De projectomgeving en de project fasen

Omdat projecten unieke realisaties zijn houden ze een grote mate van onzek-
erheid in. Om de management controle te bevorderen en om links met
lopende operaties te voorzien worden projecten opgedeeld in verschillende
fases die tesamen de ’project life cycle’ worden genoemd. Elke fase in het
project wordt gemarkeerd door één of meerdere ’deliverables’ (i.e. een tasbaar
en verifieerbaar resultaat zoals een haalbaarheidsstudie, een detail ontwerp,
een werkend prototype, etc.). De deliverables, en dus ook de fasen, zijn een
onderdeel van een sequentiële logica die de degelijke definitie van het product
van het project moeten verzekeren. De ’conclusie’ van een project fase wordt
bepaald door een review van zowel deliverables en huidige project performatie
om te beslissen of: (a) het project naar zijn volgende fase kan gaan, (b) het
kost en tijds effectief detecteren en verbeteren van fouten. Deze conclusie
reviews worden vaak ’fase uitgangen’, of ’kill points’ genoemd.

De sequentie van fasen gedefinieerd in meeste project life cycles houden
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meestel een vorm van technologie transfer in (vb. eisen voor het ontwerp).
Deliverables van de voorafgaande fase worden gewoonlijk goedgekeurd vooraleer
het werk van de volgende fase begint. Soms begint een opvolgende fase echter
vooraleer de voorgaande is afgerond (voornamelijk wanneer het risico aan-
vaarbaar is). Deze praktijk wordt ’fast tracking’ genoemd. De project life
cycles definiëren in het algemeen:

• Welk technisch werk moet gedaan worden in elke fase.

• Wie betrokken is in elke fase.

De project ’belanghebbenden’ (Eng.: stakeholders) zijn individuen en or-
ganisaties die actief betrokken zijn bij het project of wiens interesse bëınvloed
wordt door het resultaat van de project voltooiing of uitvoering (ze kunnen
vaak ook invloed uitoefenen of het project en zijn resultaten). De identifi-
catie van belanghebbenden is vaak zeer moeilijk. Sleutelpersonen onder de
belanghebbenden zijn:

• Project managers

• Klanten (eventueel verschillende lagen klanten)

• Uitvoerende organisatie.

• Project team leden.

• Sponsors (intern of extern)

Het voldoen aan de verwachtingen van de belanghebbenden is meestal
moeilijk gezien ze verschillende objectieven kunnen hebben die vaak in con-
flict komen .

De project manager moet voldoen aan een aantal algemene management
voorwaarden:

• Leidingnemend (een richting aangeven, motiveren en inspireren)

• Communiceren

• Onderhandelen

• Problem solving (problem definitie en beslissingen nemen)

• Invloed in de organisatie

Verder bestaan er nog een aantal sociaal-economische invloedsfactoren
van het project:
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• Standaarden (niet-verplichtend) en regelgeving (verplichtend).

• Internationalisatie

• Kulturele invloeden

• Sociaal-economische en milieu impact van het project

Men kan de project management processen onderverdelen in de onder-
staande soorten processen die uitvoerig besproken worden in wat volgt :

• Integratie management

• Draagwijdte management

• Tijdsmanagement

• Kost management

• Project kwaliteit

• Human resources

• Project communicatie

• Risico management

• Aanwinst management

3.3 Project integratie management

Project integratie management (Eng.: project integration management) be-
helst de processen die nodig zijn voor een goede coördinatie. Dit houdt in
dat afwegingen tussen concurrerende objectieven en alternatieven moeten
gemaakt worden. Volgende processen zijn voornamelijk integrerend :

• Project plan ontwikkeling (coördineren van alle project plans tot een
consistent, coherent document).

• Project plan uitvoering (verwezenlijken van activiteiten in het project
plan).

• Gëıntegreerde wijzigingen controle (coördinatie van veranderingen over
het volledige project).
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3.4 Project draagwijdte management

De project draagwijdte is het werk dat moet geleverd worden om een pro-
duct met gespecifieerde functies en kenmerken af te leveren. Project draagwi-
jdte management (Eng.: project scope management) bevat de processen die
verzekeren dat alle vereiste werk (maar niet meer) vervat is in het project.
Hierin wordt duidelijk gedefinieerd en gecontroleerd wat wel en niet in het
project vervat is. De volgende processen zijn vervat in het project draagwi-
jdte management.

Een van de tools die gebruikt worden tijdens de draagwijdte definitie fase
is de zogenaamde ’Work Breakdown Structure Template (WBS)’. Een WBS
is een deliverable georiënteerde groepering van project componenten die de
totale rijkwijdte van het project organiseert een definieert (werk buiten de
WBS is buiten het bestek van het project). Elk dalend niveau in een WBS
vertegenwoordigd een meer gedetailleerde beschrijving van de project deliv-
erables. De items op het laagste niveau worden ’work packages’ genoemd.
Een voorbeeld van een WBS voor een militair defensie project is gegeven in
Figuur 3.3.
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Figuur 3.3: Voorbeeld van een WBS template voor een militair project.

3.5 Project tijdsmanagement

Project tijdsmanagement omvat de processen die vereist zijn om tijdige beëindiging
van het project te verzekeren. Volgende processen kunnen onderscheiden
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worden:

• Activiteiten definitie (identificeren van de specifieke activiteiten die
moeten uitgevoerd worden om de verschillende deliverables te produc-
eren).

• Activiteiten opeenvolging (identificeren en documenteren van de inter-
actieve afhankelijkheden).

• Activiteitsduur schatting (estimatie van het aantal werkperiodes die
nodig zijn om de individuele activiteiten te vervolledigen).

• Tijdsschema controle (controleren van de veranderingen in het tijdss-
chema van het project).

Tijdens activiteiten definitie processen in het project tijdsmanagement
worden volgende tools gebruikt: ’Precedence Diagramming Method (PDM)’
(ook vaak ’activity-on-node (AON) genoemd’), ’Arrow diagramming method
(ADM)’ (ofwel ’activity- on-arrow (AOA)’).

In de PDM methode wordt een logisch project netwerk diagram gecon-
strueerd bestaande uit rechthoeken (die de activiteiten voorstellen) die ver-
bonden worden door pijlen die de afhankelijkheden aantonen (een eenvoudig
voorbeeld is gegeven in Figuur 3.4). De PDM methode wordt gebruikt in
de meeste management software pakketten. Vier types van afhankelijkheden
worden gëıllustreerd:

• Finish-to-start (de initiatie van het werk van de opvolger is afhanke-
lijk van de vervollediging van het werk van de voorganger). Dit type
wordt het meest gebruikt (alle andere types geven vaak aanleiding tot
inconsistenties in projectmanagement software).

• Finish-to-finish (de vervollediging van het werk van de opvolger is
afhankelijk van de vervollediging van het werk van de voorganger ).

• Start-to-start (de initiatie van het werk van de opvolger is afhankelijk
van de initiatie van het werk van de voorganger).

• Start-to-finish (de vervollediging van het werk van de opvolger is afhanke-
lijk van de initiatie van het werk van de voorganger).

Bij de ADM techniek wordt een project netwerk diagram geconstrueerd
met behulp van pijlen om de activiteiten weer te geven en knooppunten om
hun afhankelijkheden te visualiseren (een eenvoudig voorbeeld is gegeven in
Figuur 3.5). ADM gebruikt enkel finish-to-start afhankelijkheden en kan het
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Figuur 3.5: Voorbeeld van een ADM.

gebruik van dummy activiteiten noodzakelijk maken om alle logische relaties
correct te definiëren.

Twee bekende mathematische analyse technieken die gebruik worden ti-
jdens de activiteiten opeenvolging zijn: ’Critical Path Method (CPM)’ en
de ’Program Evaluation and Review Technique (PERT)’. Deze technieken
omvatten het berekenen van vroege en late start- en einddata. De meest ge-
bruikte techniek is de CMP methode: hierbij wordt een enkele deterministis-
che vroege en late start en einddatum berekend voor elke activiteit, gebaseerd
op een specifieke, sequentiële netwerk logische en enkele duur schatting. De
focus van CPM is het berekenen van de speling om te bepalen welke van de
activiteiten het meest flexibiliteit heeft in de opeenvolging. PERT laat de
stochastische behandeling van zowel netwerk logica als activiteitsduur schat-
tingen toe (i.e. sommige activiteiten kunnen in het geheel niet uitgevoerd
worden, andere slechts gedeeltelijk en nog andere meerdere keren). In de
PERT methode wordt een gewogen gemiddelde duur schatting gebruikt om
de activiteiten duur te berekenen (het grootste verschil met CPM is het ge-
bruik van het gemiddelde van de verdelingsfunctie in plaats van de meest
waarschijnlijke zoals gëıllustreerd in Figuur 3.6).

Twee veelvoorkomende outputs van de projecttijd management processen
zijn de ’Gantt charts’ (zie voorbeeld in Figuur 3.7) en de ’Milestone charts’
(zie voorbeeld in Figuur 3.8).
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Figuur 3.6: Berekening van de duur van een project met CPM en PERT.
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Figuur 3.7: Voorbeeld van een Gantt chart.

3.6 Project kost

Project kost management omvat de processen die nodig zijn om te verzek-
eren dat een project vervolledigd kan worden binnen het toegekende bud-
get. De belangrijkste processen rond project kost management zijn hieronder
gegeven :

• Resource planning: welke middelen (mensen, materieel, materialen,
etc.) moeten aangewend worden en tegen welke hoeveelheden?
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Figuur 3.8: Voorbeeld van een Milestone chart.

• Kost schatting: ontwikkelen van een schatting (benadering)van de kosten
van de nodige resources.

• Kost budgetering: allocatie van algemene geschatte kost voor individu-
ele activiteiten.

• Cost controle: beheersen van veranderingen op het project budget.

3.7 Projectkwaliteit

Projectkwaliteitsmanagement houdt die processen in die nodig zijn om te
verzekeren dat het project aan de vooropgestelde eisen zal voldoen. Deze zijn
vervat in alle activiteiten die de kwaliteitspolicy, de objectieven en de verant-
woordelijkheden bevatten. De projectkwaliteitsprocessen worden gëımlementeerd
door kwaliteitsplanning, quality assurance en quality control, kwaliteitsver-
betering. De belangrijkste kwaliteitsmanagement processen zijn :

• Quality planning: identificeren van de kwaliteitsstandaarden die rele-
vant zijn voor het project en bepaling van hoe hieraan te voldoen.

• Quality assurance: evalueren van de algemene project performantie op
een regelmatige basis om te verzekeren dat het project aan de relevante
kwaliteitsstandaarden zal voldoen.

• Quality control: monitoren van specifieke project resultaten om te
bepalen of ze al dan niet aan de relevante standaarden voldoen en
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identificeren van mogelijkheden om oorzaken van onbevredigende per-
formantie te elimineren.

3.8 Human resources

Project human resource management behelst die processen die vereist zijn
om op de meest effectieve manier gebruik te maken van de mensen die be-
trokken zijn bij het project (dit omvat alle project stakeholders: sponsors,
klanten, partners, etc.). Volgend hoofdprocessen maken deel uit van het
human resources management :

• Organisatorische planning: identificeren, documenteren, en toewijzen
van project rollen, verantwoordelijkheden en relaties voor rapportering.

• Staff acquisitie: het verkrijgen van de nodige HR aangesteld voor en
werkend op een project.

• Team development: tot stand koming van individuele en groepscom-
petenties om de project performatie te bevorderen. Deze processen
interageren met elkaar en met de processen in andere kennisdomeinen.

Een van de outputs die gebruikt wordt in de organisatorische planning zijn
de ’Responsibility Assignment Matrix (RAM)’ en de ’Resource Historgram’
(Figuren 3.9 en 3.10).
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Figuur 3.9: Voorbeeld van een Responsibility Assignment Matrix (RAM).
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Figuur 3.10: Voorbeeld van een Resource Historgram.

3.9 Project communicatie

Project communicatie management omvat de processen nodig om een tijdige
en gepaste generatie, verzameling, disseminatie, opslag en uiterste beschik-
baarheid van project informatie. Het voorziet in de kritische links tussen
mensen, ideeën en informatie die nodig zijn voor succes. Iedereen betrokken
bij het project moet bereid zijn om communicatie te zenden en ontvangen,
en moet verstaan hoe de communicatie het project als geheel bëınvloedt.
Hierbij zijn vooral de volgende processen belangrijk :

• Communicatie planning: bepalen van de informatie- en de commu-
nicatienoden van de stakeholders: wie heeft welke informatie nodig,
wanneer, en hoe zal de informatie aangereikt worden?

• Informatieverdeling: het tijdig beschikbaar stellen van informatie aan
de stakeholders.

• Performantie rapportering: verzamelen en disseminatie van performantie
informatie. Dit omvat status rapportering, progress report, en voor-
spelling.
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• Administratieve afsluiting: genereren, bijeenvoegen en dissimineren
van informatie voor het formaliseren van een fase of een project.

Voor het rapporteren van de performantie zijn een aantal tools voorhan-
den:

• Performatie reviews: meetings die gehouden worden om de status en
vooruitgang van en process te beoordelen (deze worden typisch gebruikt
samen met andere rapporteringstechnieken).

• Variantie analyse: vergelijken van actuele resultaten met geplande of
verwachte resultaten (vb. kosten, resources, risico of tijdsindeling).

• Trend analyse: bestuderen van de project resultaten in functie van de
tijd om te bepalen of de performatie verbeterd of verslechterd.

• Earned value (EV) analyse: omvat de berekening van drie belangrijke
waarden: 1. de geplande waarde (’Planned Value of PV’) is het deel
van de goedgekeurde kost dat wordt geschat gespendeerd te worden
voor een bepaalde activiteit gedurende een bepaalde periode. 2. De
actuele kost (’Actual Cost of AC’) is het totaal van de kosten voor het
voltrekken van werk voor de activiteit gedurende een gegeven periode
(deze kost moet overeenkomen met wat was gebudgeteerd, vb. alleen
directe kosten, alleen werkuren, etc.). 3. De Earned Value is de waarde
van het werk dat vervolledigd is. Deze drie waarden worden gebruikt in
combinatie om maten te voorzien om te toetsen of het werk uitgevoerd
is zoals gepland (zie ook Hoofdstuk 4).

Time

Actual
Costs

Data Date

Planned

Value

Cumulative
Values

Earned Value

Figuur 3.11: Voorbeeld van een grafisch rapport van performatie indicatoren
(S-curve).
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3.10 Project risico management

Risico management is het systematisch proces van het identificeren, analy-
seren en antwoorden op project risico. Het bevat het maximaliseren van de
waarschijnlijkheid en de consequenties van positieve events en het minimalis-
eren van de waarschijnlijkheid en consequenties van nadelige events voor de
project objectieven. Dit gebeurt aan de hand van de volgende zes processen :

• Risico management planning: beslissen hoe de risico management ac-
tiviteiten moeten benaderd en gepland worden.

• Risico identificatie: bepalen welke risico’s het project kunnen bëınvloeden
en het documenteren van hun karakteristieken.

• Kwalitatieve risico analyse: uitvoeren van een kwalitatieve analyse van
risico’s en condities om hun effect op het project te bëınvloeden. Dit
kan bijvoorbeeld gebeuren met behulp van de zogenaamde Probabil-
ity risk/Impact matrix (een voorbeeld van deze tool is weergegeven in
Figuur 3.12).

• Kwantitatieve risico analyse: meten van de waarschijnlijkheid en de
consequenties van de risico’s en schatten van hun implicatie voor de
project doelen.

• Risico respons planning: ontwikkelen van procedures en technieken om
de opportuniteiten te verbeteren en de threats te reduceren.

• Risico monitoring en controle: monitoren van residuele risico’s, iden-
tificeren van nieuwe risico’s uitvoeren van een risico reductie plan en
evalueren van de effectiviteit doorheen de project life cycle.
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Figuur 3.12: Voorbeeld van een PI matrix en een Risk Interview.

3.11 Projectaanwinst management

Projectaanwinst management omvat de processen die nodig zijn om goed-
eren en diensten van buiten de organisatie te verwerven die vereist zijn om
de project doelen te verwezenlijken. Voor de eenvoudigheid worden (één of
meerdere) goederen en diensten gerefereerd als product. Dit omvat de vol-
gende processen:

• Aanwinst planning: bepalen van wat aan te schaffen en wanneer.

• Aanvraag planning: documenteren van producteisen en identificeren
van potentiële bronnen.

• Aanvraag: verkrijgen van offertes, aanbiedingen, voorstellen, etc.

• Bron selectie: keuze tussen verschillende potentiële verkopers.

• Contract administratie: onderhouden van relaties met de verkoper.

• Contractafsluiting: vervolledigen en afhandelen van het contracten besluitvorm-
ing rond open items.

3.12 Introductie Microsoft Project

Microsoft Office Project is een toonaangevend programma voor projectbe-
heer, voor het plannen, beheren en overdragen van projectgegevens.
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Het gebruik van dergelijk software heeft een aantal voordelen bij het in-
vullen van het project management :

• Realistische schattingen en planningen kunnen worden gemaakt. Het
opstellen van realistische verwachtingen voor projectteams, manage-
ment en klanten hangt vaak af van hoe goed u planningen, benodigde
resources en budgetten kunt schatten. MS Project helpt bij het bouwen
van tijdlijnen en het schatten van kosten, maar ook te begrijpen welke
invloed wijzigingen of vertragingen van specifieke taken hebben op het
totale project.

• Hulp bij planning en beheer. Met behulp van de projectrichtlijnen
kan men snel nieuwe projecten instellen, taken en resources beheren,
planningen bijhouden en projectgegevens rapporteren.

• Tijdige projectrapportage en statusinformatie. Men kan nauwkeurige
projectrapporten produceren door een keuze te maken uit lijst met
kant-en-klare rapporten die kunnen aanpast worden. Op die manier
kan het management beter gëınformeerd worden over de projectstatus
en de voortgang van het project door de huidige marge, kritieke paden
en meerdere basislijnen te berekenen.

• Betere toewijzing van resources. Met MS Project kan men eenvoudig
resources aan taken toewijzen en toewijzingen aanpassen om conflicten
en overbezetting op te lossen. Zo heeft men meer controle en flexibiliteit
bij het beheren van resources, projectplanningen en kosten.

• Effectieve presentatie van projectgegevens. Projectmanagers kunnen
gegevens snel en eenvoudig in diverse indelingen presenteren. Gegevens
kunnen eenvoudig getransporteerd worden naar andere applicaties voor
presentatie doeleinden.

• MS Project heeft een groot aantal gebruikers, zodat communicatie van
de project management gegevens met klanten, leveranciers en andere
stakeholders mogelijk is.

Een introductie tot Microsoft Project wordt gegeven in Appendix C.



Hoofdstuk 4

Economische aspecten in het
ontwerpproces

4.1 Economische beslissingen nemen

4.1.1 Actualiseren van kosten en inkomsten

De economische consideraties kunnen vaak een belangrijkere rol spelen in het
beslissingsproces tijdens het ontwerp dan de puur technische kenmerken. In
een groot ontwikkelingsproces komt het voorspellen van kosten en inkomsten
voor tijdens verschillende tijdstippen in het project. De methodologie om
deze klasse van problemen aan te pakken noemt men ’cost engineering’ (of
ook ’engineering economy’). Het basisconcept in ’cost engineering’ is dat geld
een tijdswaarde heeft: 1 Euro vandaag uitbetalen kost meer dan volgend jaar
1 Euro uitbetalen. Dit tijdsaspect maakt het winstgevend om kosten naar
de toekomst uit te stellen en inkomsten naar heden te verschuiven.

Indien we een som geld P lenen tegen een intrest i dan is de jaarlijkse
kost van de intrest gelijk aan I = Pi. Indien de lening afbetaald wordt in
een schijf S op het einde van n jaren dan is het vereiste bedrag:

S = P + nI = P + nP i (4.1)

waar S = de toekomstige waarde (Eng: future value), P de huidige waarde
(Eng: present value), I de jaarlijkse kost van de intrest, i de jaarlijkse in-
trestvoet en n het aantal jaren. Tegelijkertijd kan uit de formule in Vergeli-
jking 4.1 de huidige waarde berekend worden uit de toekomstige waarde.
Vb. 1600 Euro binnen 6 jaar tegen 10% intrest is nu 1000 Euro waard. Dit
noemt men het actualiseren van een bedrag. Om de tijdsafhankelijkheid van
geld voor te stellen wordt gebruik gemaakt van een geld-tijdsdiagramma dat
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de kosten en inkomsten op een tijdschaal uitzet, waarbij de grootte van de
bedragen weergegeven worden door de lengte van de pijlen die de bedragen
voorstellen (zie figuur 4.1).

 

0 1 2 3 4 5 6 7 8 Tijd 

Heden 

Betalingen (kosten) 

Facturen (inkomsten) 

Figuur 4.1: Voorbeeld van een geld-tijdsdiagramma.

Financiële transacties gebeuren meestal echter d.m.v. een samengestelde
intrest: de intrest van een bepaalde periode wordt toegevoegd aan het basis
bedrag. Dit maakt dat na n jaren de toekomstige waarde:

S = P (1 + i)n = PFPS (4.2)

bedraagt, met FPS = (1 + i)n de factor die de huidige waarde in de toekom-
stige waarde omzet.

In het bankmilieu wordt vaak een samengestelde intrest op periodes van
minder dan een jaar gebruikt (dit geeft aanleiding tot een verhoging van de
effectieve intrest). De toekomstige waarde wordt dan:

S = P [(1 +
r

p
)p]n (4.3)

met r de nominale jaarlijkse intrestvoet en p het aantal periodes per jaar. De
formule in Vergelijking 4.1 kan ook voor periodes kleiner dan een jaar gebruikt
worden door een effectieve jaarlijkse intrestvoet (ook return, opbrengst of
rendement) i′ = (1+r/p)p

−1 te gebruiken (voor jaarlijkse intrestvoeten zijn
immers tabellen beschikbaar). De effectieve jaarlijkse opbrengst stijgt dan
met het aantal jaarlijkse periodes (zie Tabel 4.1). Als limietgeval, wanneer
p → ∞ :

S = P lim
p→∞

(1 +
r

p
)pn (4.4)

Wetende dat limx→∞(1 + x)1/x = e wordt dit S = Pern.
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Frequentie van
samenstelling

♯ intrestperiodes
p

Intrestvoet voor
periode

Effectief jaarli-
jkse rendement

Jaarlijks 1 12 12.0
Halfjaarlijks 2 6 12.4
Per kwartaal 4 3 12.6
Maandelijks 12 1 12.7
Continu ∞ 0 12.75

Tabel 4.1: Invloed van de samenstellingsperiode op de effectieve jaarlijkse
return.

In vele situaties komen uniforme reeksen van facturen of betalingen die
tegelijkertijd voorkomen op het einde van elke periode (vb. aflossing, verzek-
ering, pensioen). Na het betalen van een jaarlijkse som R, zal na n− 1 jaren
het volgend samengesteld bedrag bereikt zijn :

S = R(1 + i) + R(1 + i)2 + · · ·+ R(1 + i)(n−1) (4.5)

Ofwel, na enig rekenwerk : S = R (1+i)n
−1

i
, of omgekeerd :

R = S
i

(1 + i)n
− 1

= SFSR (4.6)

waar men FSR de ’sinking fund factor (SFF)’ noemt.
Door Vergelijkingen 4.2 en 4.6 te combineren komen we tot de huidige

waarde van een uniforme reeks betalingen R:

R = P
i(1 + i)n

(1 + i)n
− 1

= PFPR (4.7)

met FPR de ’capital recovery factor (CRF)’. Deze R geeft de jaarlijkse afloss-
ing die nodig is om een investering P met intrest i over n jaren af te lossen.
De relatie tussen de SFF en de CRF wordt gegeven door: FPR = FSR + i.

4.1.2 Kost vergelijkingen

Om een economische beslissing te nemen tussen twee verschillende investerin-
gen zijn een een aantal analyses beschikbaar: ’Net Present Worth (NPW)
Analysis’, ’Annual Cost Analysis’ en ’Capitalized Cost Analysis’. De NPW
analyse wordt gebruikt wanneer twee alternatieven een gemeenschappelijke
tijdspanne hebben. Beschouw bijvoorbeeld twee machines die een levensduur
hebben van vijf jaar en kosten en opbrengsten zoals weergegeven in Tabel 4.2
Welke van de twee machines is het meest economisch wanneer het geld 10%
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Inkomsten/Kost A B
Initiële kost 25000 15000
Jaarlijkse onderhoudskost 2000 4000
Renovatie jaar 3 0 3500
Restwaarde 3000 0
Jaarlijks profijt door betere kwaliteit 500 0

Tabel 4.2: Voorbeeld van kosten en inkomsten van twee machines voor het
berekenen van de NPW.

waard is? Hiervoor stelt men eerst een geld-tijd diagramma op (Figuur 4.2)
waarmee men de NPWs PA en PB voor machines A en B berekend:

PA = 25000 + (2000 − 500)FRP − 3000FSP = 28828 (4.8)

PB = 15000 + 4000FRP + 3500FSP = 32793 (4.9)

Hieruit kan besloten worden dat machine A het meest economisch is. 

0 1 2 3 4 5 Tijd 

Machine A 

2000 2000 2000 2000 2000 

25000 

500 500 500 500 500 

3000 

0 1 2 3 4 5 Tijd 

4000 4000 4000 4000 4000 

15000 

3500 

Machine B 

Figuur 4.2: Voorbeeld van de geld-tijdsdiagramma’s voor twee machines.

Wanneer de tijdsperiodes van de twee alternatieven niet gelijk zijn kan
de NPW Pn1

gebaseerd op een periode n1 omgezet worden in een equivalente
NPW Pn2

:

Pn2
=

Pn1
FPR,n1

FPR,n2

(4.10)

In de jaarlijkse kost analyse methode wordt de ’cash flow’ (netto jaarlijkse
cash inkomsten + afschrijving) over een tijdspanne geconverteerd naar een
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Inkomsten/Kost A B
Eerste kost 10000 18000
Geschatte levensduur 20 jaar 35 jaar
Geschatte restwaarde 0 3000
Jaarlijkse werkingskost 4000 3000

Tabel 4.3: Voorbeeld van kosten en inkomsten van twee machines voor het
berekenen van de jaarlijkse kost.

equivalente uniforme jaarlijkse kost R. Voor machines A en B met gegevens
uit Tabel 4.3 wordt deze jaarlijkse kost RA en PB als volgt berekend:

RA = 10000FPR + 4000 = 5175 (4.11)

RB = (18000 − 3000)FPR + 3000 × 0.1 + 3000 = 4855 (4.12)

Hieruit kan besloten worden dat machine B het meest economisch is.
Capitalized cost analyse is een bijzonder geval van NPW analyse. De ge-

activeerde kost (Eng.: capitalized cost) van een project is de huidige waarde
indien dit project oneindig lang zou duren (n = ∞). Dit werd initieel ingevo-
erd voor publieke bouwprojecten die een zeer lange duur en opvolgingsperi-
ode hebben (vb. bouw van dammen). Het wordt vaak gebruikt omdat de
beslissingen onafhankelijk zijn van de tijdsperiode van de alternatieven. De
geactiveerde kost K kan door gebruik van Formule 4.10 met n1 = n en
n2 = ∞ berekend worden:

K = P∞ = P
(1 + i)n

(1 + i)n
− 1

= PFPK,n (4.13)

waarbij FPK,n =
FPR,n

i
. Wetende dat voor een jaarlijkse betaling R geldt dat

P = RFRP , kan de geactiveerde kost uitgedrukt worden als: K = R
i

Het gebruik van de drie methoden voor het vergelijken van kosten geeft
hetzelfde resultaat zodat de keuze van de methode afhankelijk is van de
persoonlijke voorkeur.

Een alternatief voor het positieve NPV criterium voor de waardering van
een project is de eis dat de ’Internal Rate of Return (IRR)’ de marginale
kapitaalskost moet overschrijden. De IRR is de rentevoet die de huidige
waarde van de cash toevoer van een project gelijk maakt aan de geactu-
aliseerde waarde van de investering (dus de IRR is de rentevoet r die de
NPV gelijk aan nul maakt). Het berekenen van de IRR vereist een iteratieve
(meestal trial-and-error) aanpak. De IRR kan worden gëınterpreteerd als de
maximum intrestvoet dat een bedrijf kan betalen indien het project volledig
gefinanceerd moet worden door leningen (en de cash flow wordt gebruikt
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om de leningen en de intrest terug te betalen). Indien de IRR de leenkost
overschrijdt dan moet het project aanvaard worden. Anderzijds, indien het
bedrijf in zijn eigen financiering voorziet, moet het project aanvaard wor-
den indien de IRR de marginale rente overschrijdt die elders bekomen kan
worden.

4.1.3 Afschrijvingen

Materieel lijdt aan een verlies in waarde met het verstrijken van de tijd (dit
kan door slijtage of door verlies van technologische efficiëntie of waarde).
Daarom moet een bedrijf elk jaar genoeg geld opzij leggen om een fonds te
accumuleren om het materieel te vervangen. Dit bedrag noemt men de af-
schrijving. Een ander aspect van afschrijving is dat de overheid de aftrek
van de winst toelaat. In een kapitaal intensieve handel kan afschrijving een
sterke invloed hebben op de hoeveelheid belastingen die moeten betaald wor-
den. De belangrijkste vragen die dienen beantwoord te worden zijn: (a) wat
is de tijdspanne waarover afschrijving kan genomen worden, (b) hoe moet de
afschrijving gespreid worden over deze periode? Er zijn drie veelgebruikte
afschrijvingsmethodes:

Lineaire afschrijving (Eng.: Straight-line depreciation) Een gelijk bedrag
wordt jaarlijks opzij gezet:

D =
Ci − Cs

n
(4.14)

waar Ci de initiële kost, Cs de restwaarde (Eng.: Salvage value) en n
het aantal jaren in de afschrijving. De boekwaarde B is de initiële kost
min de som van de afschrijvingskosten. Voor lineaire afschrijving is dit
na j jaren: B = Ci −

j
n
(Ci − Cs).

Degressieve afschrijving (Eng.: Declining Balance) De degressieve meth-
ode voorziet in een versnelde afschrijvingsmethode in de eerste jaren.
Het afschrijvingsbedrag Dj voor het j-de jaar is een vast deel FDB van
de boekwaarde in het begin van het j-de jaar:

Dj = Bj−1FDB (4.15)

met FDB = 1 −
n

√

Cs

Ci
en Bj−1 = Ci(1 − FDB)j−1. De snelste afschrijv-

ingsperiode wordt bekomen met de dubbele degressieve methode waar
FDDB en Bj−1 = Ci(1 − 2/n)j−1. Omdat de degressieve methode de
boekwaarde niet altijd reduceert tot de restwaarde na n jaren (hier-

voor moet FDB = 1 −
n

√

Cs

Ci
) is het mogelijk om over te schakelen op

een lineaire afschrijvingsmethode na een aantal jaren.
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Jaar Lineair Degressief Versneld
1 1000 1807 1667
2 1000 1263 1333
3 1000 882 1000
4 1000 616 667
5 1000 431 333

Tabel 4.4: Voorbeeld van drie afschrijvingsmethodes voor een initiële kost
Ci = 6000, restwaarde Cs = 1000 en n = 5 jaren.

Versnelde afschrijving Het jaarlijkse afschijvingsbedrag is berekend door
de som van de jaren te nemen en voor elk de jaren het jaar nummer
(achteraan te beginnen) te delen door deze som: FSOY D,j = n−j+1

P

i=1
ni

.

Een voorbeeld van de drie afschrijvingsmethodes is gegeven in Tabel 4.4.

4.1.4 Belastingen

Belastingen zijn een zeer belangrijke factor in economische engineering beslissin-
gen. Vier types belastingen kunnen onderscheiden worden:

1. Eigendomsbelastingen: gebaseerd op de eigendom waarover een bedrijf
beschikt (gebouwen, land, etc.). Deze belasting varieert niet met de
winst en is meestal niet hoog.

2. Verkoopstax: wordt opgelegd op verkoop van producten en wordt be-
taald door de aankoper.

3. Accijnzen (Eng.: Excercise Tax ): worden aan de klanten doorgerekend.

4. Winstbelasting (Eng.: Income Tax ): worden geheven op bedrijfswinst
(vennootschapsbelasting) en persoonlijke inkomens. Dit is de belangri-
jkste vorm van belastingen voor economische beslissingen.

Het tarief van de vennootschapsbelasting is voor aanslagjaar 2005 (inkom-
sten 2004) vastgesteld op 33%. Wanneer het belastbare inkomen niet meer
dan 322.500,00 EUR bedraagt, wordt de belasting evenwel als volgt vast-
gesteld: op de schijf van 0 tot 25.000,00 EUR: 24,25%; op de schijf van
25.000,00 EUR tot 90.000,00 EUR: 31%; op de schijf van 90.000,00 EUR tot
322.500,00 EUR: 34,5%. Daarnaast wordt nog 3% algemene crisis belasting
(ACB) gëınd (bron: http://minfin.fgov.be ). Het effect van vennootschaps-
belastingen is dat het beleggingsrendement (Eng.: Return on Investment
(ROI)) wordt gereduceerd: r = i(1 − t) waarbij i en r de ROI vóór en na
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belasting en t de belastingsvoet. De huidige waarde, rekening houdend met
de afschrijving (die ervoor zorgt dat elk jaar een bedrag DfCdt aan belasting
minder moet betaald worden) is gelijk aan:

P = Cd − Cdtφ (4.16)

waar Cd = Ci − Cs de afschrijfbare kapitaalsinvestering en φ =
∑n

i=1

Dfi

(1+r)i

met Dfi
afhankelijk van de afschrijvingsmethode (dit is het geactualiseerde

bedrag van alle afschrijvingsbedragen).
De uitgaven van een bedrijf kunnen verdeeld worden in twee categorieën:

geactieveerde kosten (productie materieel, gebouwen, etc.) en gewone kosten
(arbeid, materiaalkost, etc.). De gewone kosten mogen onmiddellijk afgetrokken
worden van het bruto resultaat (Eng.: gross income) terwijl voor de geac-
tiveerde kosten alleen de jaarlijkse afschrijvingskost mag afgetrokken wor-
den. Wanneer kapitaalgoederen verkocht worden wordt een winst of verlies
bekomen door de bookwaarde van de goederen af te trekken van de verkoop-
prijs.

4.1.5 Rentabiliteit

Eén van de doestellingen van engineering economy is het bepalen van de
rentabiliteit (Eng.: profitability) van projecten of investeringen. Vier meth-
odes om de rentabiliteit te evalueren worden vaak gebruikt:

• Rendement van investeringen (Eng.: Return-on-investment (ROI)).

• Terugverdien-periode (Eng.: Payback period).

• Huidige nettowaarde (Eng.: Net Present Worth (NPW)).

• Contante waarde van toekomstige kasstroom (Eng.: Discounted Cash
Flow (DCF)).

Om deze methodes beter te begrijpen wordt eerst het begrip kasstroom
(Eng.: Cash Flow) uitgelegd. Cash flow meet de stroom van fondsen in
(positieve cash flow) of uit (negatieve cash flow) een project. Vanuit een
boekhoudkundig standpunt wordt cash flow gedefinieerd als: ”cash flow =
netto jaarlijks geldinkomsten + afschrijving”. Tabel 4.5 toont hoe cash flow
kan berekend worden voor een eenvoudig voorbeeld. Een voorbeeld van de
evolutie van de cash flow in een investering is gegeven in Figuur 4.3.

De ROI is de eenvoudigste maat van rentabiliteit en wordt berekend va-
nuit een strikt boekhoudkundig standpunt zonder consideratie van de ti-
jdswaarde van geld. Het is de ratio van een maat van winst of cash baten tot



4.1. ECONOMISCHE BESLISSINGEN NEMEN 81

(1): Omzet (Eng.: Revenue) 500000
(2): Bedrijfskosten (Eng.: Operating costs) 360000
(3): (1)-(2)= Bruto winst (Eng.: Gross earnings) 140000
(4): Jaarlijks afschrijvingsbedrag 60000
(5): (3)-(4)= belastbaar inkomen (Eng.: taxable income) 80000
(6): (5)×0.5= belasting 40000
(7): (5)-(6)= netto winst na belasting (Eng.: net profit after taxes) 40000
Netto cash flow, na belasting
(7)+(4) 100000

Tabel 4.5: Voorbeeld van de berekening van cash flow

de kapitaalsinvestering. Hoewel dit een eenvoudige ratio is zijn er verschil-
lende manieren om hem te berekenen, gebaseerd op:

1. nettowinst voor belastingen

2. nettowinst na belastingen

3. jaarlijkse baten voor belastingen

4. jaarlijkse baten na belastingen

Voorbeeld: Een kapitaalsinvestering bedraagt 360000 en heeft een 6-
jarige duur en een 60000 restwaarde. Het werkkapitaal is 40000. De totale
nettowinst na belastingen over 6 jaren wordt 167000 geschat. Wat is de ROI?
Met een lineaire afschrijving bedraagt het jaarlijks bedrag 50000, terwijl de
jaarlijkse netto winst 28000 bedraagt. De ROI is dan: ROI = 28000

360000+40000
=

0.07.
De payback periode is de tijdspanne die nodig is opdat de cash flow

volledig de initiële kapitaalsinvestering kan recupereren. Hoewel de payback
methode cash flow gebruikt, houdt het geen rekening met de tijdswaarde van
het geld. De nadruk ligt op de snelle incassering van een investering. Gebruik
makende van de methode worden ook geen cash flows of winst gëıncasseerd na
de payback periode in beschouwing genomen. Een voorbeeld wordt gegeven
in Tabel 4.7

Zoals voorheen gezien werd is de NPW gelijk aan de huidige waarde van
de baten min de huidige waarde van de kosten. M.b.v. deze techniek wordt
de voorziene cash flow (zowel positief als negatief) doorheen de duur van
een project geactualiseerd tot op heden met een intrestvoet die de minimum
aanvaardbare rendement voorstelt. Gezien de NPW afhankelijk is van de
projectduur mogen, strikt gezien, de projecten niet vergeleken worden indien
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Figuur 4.3: Voorbeeld van de cash flow in de levenscyclus van een investering.

ze over verschillende termijnen lopen. De NPW is afhankelijk van de in-
trestvoet: voor lage intrestvoeten wordt de NPW kleiner en voor hoge wordt
hij groter. De intrestwaarde (of rate of return) i waarvoor NPW=0 noemt
men de ’discounted cash flow (DCF)’ of ook ’de internal rate of return’.

Deze DCF kan op verschillende manieren uitgedrukt worden:

• PW van baten - PW van kosten = 0

•
PW van baten
PW van kosten

= 1

• PW van baten = PW van kosten

Indien de DCF 20% bedraagt wil dit zeggen dat 20% per jaar zal verdiend
worden bij de investering in het project. Afschrijving wordt impliciet vervat
in de NPW and DCF berekeningen door de definitie van de cash flow. Gezien
de DCF methode de rentabiliteit in procent uitdrukt in tegenstelling tot de
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Jaar Project A Project B
0 -100000 -100000
1 50000 0
2 30000 10000
3 20000 20000
4 10000 30000
5 0 40000
6 0 50000
7 0 60000

10000 110000
Payback periode 3 jaar 5 jaar

Tabel 4.6: Voorbeeld van een payback period berekening

NPW wordt de eerste vaak gebruikt. Anderzijds kunnen voor een NPW
van verschillende deelprojecten de bedragen opgeteld worden waar dit niet
mogelijk is voor de DCF.

Voorbeeld: een machine heeft een initiële kost van 10000 en een rest-
waarde van 2000 na 5 jaren. Jaarlijkse besparingen door het gebruik bedra-
gen 5000 en de jaarlijkse werkingskost is 1800. De belastingsvoet is 50%.
Wat is de DCF? Gebruik makende van lineaire afschrijving berekenen we het
jaarlijks afschrijvingsbedrag: D = Ci−Cs

n
= 1600. De jaarlijkse cash flow na

belastingen bedraagt: ACF = (5000 − 1800)(1 − 0.5) + 16000.5 = 2400. De
NPW is gelijk aan:

NPW = 0 = −10000 + 2400FRP + 2000FSP (4.17)

Dit is voldaan indien i = 11.2%, wat ons de DCF geeft.

4.1.6 Andere rentabiliteitsfactoren

Naast indicatoren in vorige sectie zijn er nog een groot aantal andere factoren
die de rentabiliteit bëınvloeden. Allereerst dient opgemerkt te worden dat
rentabiliteit, dat een lange termijn beslissingsparameter voor economische
projecten is, niets te maken heeft met winst (winst wordt gemeten door
boekhouders en zijn waarde kan gemanipuleerd worden en is variabel op
korte termijn). Het schatten van rentabiliteit vereist een predictie van de
toekomstige cash flow, dat op zijn beurt een betrouwbare schatting van de
verkoopsvolumes en -prijzen en de beschikbaarheid en prijs van materialen
vereist (vb. evolutie van de olieprijzen).

De geschatte investeringen in machines en faciliteiten zijn vaak het meest
nauwkeurig in een rentabiliteitsanalyse (dit zal in volgende sectie verder be-
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sproken worden). De afschrijvingsmethode bëınvloed hoe de kost is verdeeld
over de jaren van een project, en bepaald bijgevolg hoe de cash flow zal zijn.
Wanneer een investering afgeschreven wordt over een lange periode zijn de
kosten onderschat en is de verkoopprijs te laag. Dit in combinatie met in-
flatie kan resulteren in een onvoldoende cash flow om herinvestering toe te
laten.

Een aantal technische beslissingen zijn onmiddellijk gerelateerd tot in-
vesteringsbeleid en rentabiliteit. In het ontwerp stadium kan het mogelijk
zijn een mate van product superioriteit te verzekeren die groter is dan nodig
is door de huidige markt. Later, wanneer concurrenten de markt penetreren
kan deze superioriteit zinvol zijn niettegenstaande ze niet bereikt is zonder
initiële kost. Economisten zijn meestal voorstanders van een producteenheid
die net groot genoeg is om geabsorbeerd te worden door de markt. Ni-
ettegenstaande dit een hoge rentabiliteit inhoud, bestaat het risico dat de
continüıteit niet kan verzekerd worden indien de productielijn in onderhoud
is.

De rentabiliteit van een product kan bëınvloed worden door cost allo-
catie beslissingen. Deze factoren zoals overhead, nutskosten, transfer pri-
jzen tussen divisies en schrootprijzen vereisen vaak arbitraire beslissingen
omtrent allocaties tussen verschillende producten. Sommige producten wor-
den vaak bevoordeelt t.o.v. andere door kost allocatie beleid. Een bedrijf
kan bijvoorbeeld beslissen een product lijn met een beperkte toekomst (een
’cash cow’) uit te melken om de groei van een nieuw maar veelbelovend pro-
duct te stimuleren. De verschillende product categorieën naar kost allocatie
(’cash cows’, ’dogs’, ’stars’ en ’question marks’) zijn onderverdeeld in de zoge-
naamde Boston Consultancy Group (BCG) matrix zoals deze is weergegeven
in Figuur 4.4. In de BCG matrix zijn de producten onderverdeeld in volgens
marktaandeel en groeipotentieel :

• Cash cow: hoog marktaandeel in een stabiele, volwassen markt. Deze
opbrengsten dienen gebruikt te worden om in andere producten te in-
vesteren.

• Star: een hoog marktaandeel in een groeimarkt. Met gerichte in-
vesteringen dient men de voorsprong te behouden tot de markt vol-
wassen wordt en dit een cash cow wordt.

• Question mark (ook wel Problem child) : een klein marktaandeel in een
groeimarkt. Het is nog onzeker of dit een star of een dog zal worden.

• Dog: kleine marktaandeel in een volwassen markt. Indien het bedrijf
geen strategisch belang bij dit product heeft, dient zij haar af te stoten.
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Figuur 4.4: BCG matrix.

4.1.7 Break-even analyse

Een break-even analyse wordt vaak gebruikt wanneer er een onzekerheid is
over één van de factoren in een economische studie. Het break-even punt is
de waarde voor een factor bij dewelke het project marginaal wordt gerecht-
vaardigd.

Voorbeeld: Beschouw een 20000 investering op 5 jaar. De restwaarde
is 4000 en het minimale aanvaardbare rendement is 8%. De investering pro-
duceert een jaarlijks voordeel van 10000 met 3000 werkingskosten. Veron-
derstel dat er een beduidende onzekerheid is m.b.t. de 5-jarige levensduur
van de machine. Gebruik makende van de jaarlijkse kost methode:

10000 − 3000 − (20000− 4000)FPR − 4000 × 0.08 = 0 (4.18)

waaruit volgt FPR = 0.417 en dus n = 2.8 jaren. M.a.w. indien de machine
geen 2.8 jaren meegaat dan kan de investering niet gerechtvaardigd worden.

Break-even analyse wordt vaak gebruikt bij beslissingen omtrent instal-
laties in meerdere delen, waarbij de vraag is om de volledige investering
onmiddellijk te doen of op te splitsen in een onmiddellijke investering en een
latere.

Voorbeeld: Een synthetische brandstof fabriek kost 100 miljoen voor
het eerste stadium en 120 miljoen voor het tweede (n jaren in de toekomst).
Indien de fabriek op volledige capaciteit wordt gebouwd is een 140 miljoen
investering nodig. Wat is de verkiesbare oplossing?

n = n jaren : PW = 100 + 120(FSP ) (4.19)

n = 5 jaren : PW = 100 + 120(0.6201) = 174.4 miljoen (4.20)

n = 10 jaren : PW = 100 + 120(0.3855) = 146.3 miljoen (4.21)

n = 20 jaren : PW = 100 + 120(0.1468) = 117.3 miljoen (4.22)

n = 30 jaren : PW = 100 + 120(0.0573) = 106.9 miljoen (4.23)
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Het break-even punt is ongeveer na 12 jaren. Indien de volledige capaciteit
nodig is voor die tijd is het te verkiezen onmiddellijk de volle capaciteit te
voorzien.

4.2 Kost

Een ontwerp is niet volledig tot men een goed idee heeft van de kost om
het ontwerp te bouwen of het product te fabriceren. In het algemeen is een
goedkoop ontwerp succesvol in een vrije markt, en bijgevolg komt het er vaak
op neer om parameters van het ontwerp te optimaliseren naar de kost.

Het begrijpen van de elementen die de kost uitmaken is van vitaal be-
lang gezien de concurrentie tussen bedrijven en naties feller is dan ooit. De
wereld wordt een gigantische markt waar nieuwe ontwikkelingslanden met
zeer lage lonen technologie verwerven en succesvol concurreren tegen geves-
tigde gëındustrialiseerde landen. Om markten te behouden vergt een gede-
tailleerde kennis van kosten en het verstaan van hoe nieuwe technologie kan
leiden tot lagere kosten. Een voorbeeld van hoe nieuwe technologieën de kost
per component dramatisch kunnen doen dalen is in de microelectronica (zie
Figuur 4.5).

Grofweg zijn er twee klassen van situaties inbegrepen in kost evaluatie:

1. Schatten van de kosten van een gebouw of fabriek of installeren van een
proces binnen een fabriek om een lijn van producten te produceren.

2. Schatten van de productiekost van een onderdeel gebaseerd op een se-
quentie van fabricage stappen.

De geschatte kost kan dan gebruikt worden om:

1. Informatie te voorzien om de kostprijs van een product te kennen, of
een offerte op te stellen voor een goed of dienst.

2. Om de meest rendabele methode van een proces of materiaal te kennen
om een product te fabriceren.

3. Om te gebruiken als basis voor een kost reductie programma.

4. Om standaarden te bepalen van productie performantie die gebruikt
kan worden om de kosten te controleren.

5. Om input betreffende de rentabiliteit van een nieuw product te geven.



4.2. KOST 87

 

 

1 10 102 104103 105 

Aantal componenten per geïntegreerd circuit 

R
el

a
ti

ev
e 

p
ro

d
u

ct
ie

k
o
st

 p
er

 c
o
m

p
o
n

en
t 

1 

10 

10
2
 

104
 

10
3
 

10
5
 

1962 

1965 

1970 

Figuur 4.5: Evolutie van de kost van elektronische componenten [11].

De informatie rond kosten wordt zelden gepubliceerd in technische liter-
atuur gezien ze beschouwd wordt als eigendom van het bedrijf.

In deze paragraaf worden kostelementen gëıdentificeerd en worden enkele
algemene kost evaluatie methodes besproken (er wordt niet ingegaan op de
zeer specifieke kost evaluatie methodes van verschillende types industrieën
en organisaties).

4.2.1 Kost categorieën

Er bestaan twee brede categorieën van kosten:

1. Doorlopende kosten (Eng.: recurring costs): deze zijn directe functies
van het fabricage proces en komen keer op keer voor (ze worden ook
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vaak operationele kosten of fabricage kosten genoemd).

2. Incidentele kosten (Eng.: non-recurring costs): dit zijn éénmalige kosten
die ingedeeld worden in vaste kapitaalskosten (vb. gebouwen) en niet
afgeschreven kapitaalskosten (vb. landgoed).

Verder wordt er vaak gebruik gemaakt van de classificatie tussen vaste
en variabele kosten. Vaste kosten zijn, in tegenstelling tot variabele kosten,
onafhankelijk van de productiesnelheid en het productievolume. Men spreekt
van een ’directe kost’ wanneer ze geattribueerd kan worden aan een bepaald
product of proces. Indirecte kosten zijn gespreid over de gehele fabriek. Deze
categorieën kunnen nog verder onderverdeeld worden:
Vaste kosten:

1. Indirecte bedrijfskosten

(a) Investeringskosten

i. Afschrijving op investeringen

ii. Intrest op kapitaalsinvesteringen en inventaris

iii. Eigendomsbelasting

iv. Verzekeringen

(b) Overhead kosten

i. Technische diensten (engineering)

ii. Niet-technische diensten (administratief personeel, bewaking,
etc.)

iii. Algemene voorzieningen

iv. Huur van materieel

2. Management uitgaven

(a) Aandelen van kaderfuncties

(b) Juridisch personeel

(c) Aandelen van R&D personeel

3. Verkoopsuitgaven

(a) Verkoopspersoneel

(b) Magazijn- en leveringskosten

(c) Technisch personeel (vb. dienst na verkoop)

Vaste kosten:
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1. Materialen

2. Arbeid (inclusief extra-legale voordelen)

3. Directe product supervisie

4. Onderhoudskosten

5. Stroom en nutsvoorzieningen

6. Kwaliteitscontrole personeel

7. Royalties

8. Packaging en opslag kosten.

9. Schroot verliezen en verspilling

De elementen van kost zijn samengesteld tot de verkoopprijs van een
product (zie Figuur 4.6).
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Figuur 4.6: Verdeling van de verkoopprijs van een product in kosten.

Een andere belangrijke kost is het werkingskapitaal (de fondsen die bovenop
het vast kapitaal moeten voorzien worden om een project op te starten en op
te volgen): ruw materiaal, halfafgewerkte producten, afgewerkte producten
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in de inventaris, vorderingen en cash. Dit werkingskapitaal is bezet tijdens
het project maar kan gerecupereerd worden op het einde van het project.

Een concept dat een ruwe schatting van de investeringskost voor een
nieuw product geeft is de omzet ratio (Eng.: ’turnover ratio’ ): dit is de
omzet gedeeld door de totale investering. In de chemische industrie is deze
turnover ratio typisch 1 en in de staalindustrie 0.6.

Het feit dat variabele kosten afhangen van het productievolume leidt tot
het begrip ’break-even point’ (zie Figuur 4.7). Het bepalen van het produc-
tievolume waarbij het break-even punt wordt overschreden is zeer belangrijk.
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Figuur 4.7: Illustratie van het break even punt.

4.2.2 Kost schattingsmethodes

Drie methodes worden gebruikt om kosten te evalueren: ’de methode engi-
neering’, ’kosten door analogie’ en statistische analyse van historische gegevens.

In de methode engineering aanpak worden de verschillende elementen van
arbeid in detail gëıdentificeerd en opgeteld tot de totale kost per onderdeel.
Een vereenvoudigd voorbeeld van de productie van een fitting wordt gegeven
in Tabel 4.7.

Bij de analogie aanpak worden de toekomstige kosten van een project
gebaseerd op de kosten per onderdeel van een vorig vergelijkbaar project
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Operaties Materiaal Arbeid Overhead Totaal
Stalen smeedstuk 37.00€ 37.00€

Opstart op freesmachine 0.20€ 0.80€ 1.00€

Opstart op boormachine Arbeid Overhead 3.25€

Acht gaten boren Arbeid Overhead 1.91€

Stuk schoonmaken en verven Arbeid Overhead 4.95€

Totaal 37.00€ 2.40€ 9.91€ 49.3€

Tabel 4.7: Voorbeeld van de kosten per onderdeel

(gebruik makende van dezelfde technologie en geproduceerd op dezelfde lo-
catie). In de statistische aanpak worden technieken als regressie analyse
gebruikt om relaties tussen kost en parameters van het systeem (gewicht,
snelheid, vermogen) te bepalen.

Omdat de koopkracht van geld daalt in functie van de tijd zijn alle
bepaalde kosten in feite achterhaald. Om dit te compenseren worden kost
indices gebruikt. De vroegere kosten Ct1 worden dan getransfereerd naar
huidige kosten Ct1 :

Ct2 = Ct1

It2

It1

waarbij de indices It1 en It2 bijvoorbeeld te vinden zijn bij het Ministerie van
Economie (www.mineco.fgov.be).

De kost van de meeste kapitaalmiddelen is niet lineair afhankelijk van
de grootte of capaciteit van het materieel. Het verdubbelen van het ver-
mogen van een motor laat de kost toenemen met ongeveer de helft. De
kost-capaciteit relatie wordt gewoonlijk uitgedrukt als:

C1 = C0(
Q1

Q2
)x (4.24)

waar C1 en C0 de respectievelijke kapitaalkosten zijn geassocieerd met de
capaciteit Q1 en Q0. De exponent x varieert tussen 0.4 en 0.8 en is ongeveer
0.6 voor veel materieel (daarom wordt de regel in Vergelijking 4.24 vaak de
’zes tienden regel’ genoemd).

Fabricage kosten en operationele kosten zijn gelijk aan de directe produc-
tiekosten + vaste kosten + bedrijfs overhead kosten. De componenten van
directe productiekosten (variabele kosten) zijn de volgende:

1. Ruw materiaal (min schroot of verkochte bijproducten).

2. Arbeid (aantal manuren)

3. Directe supervisie en administratieve arbeid
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4. Nutsvoorzieningen

5. Onderhoud en hertellingen (typisch 3 tot 10% van de fabrieksinvester-
ing per jaar).

6. Operationele hulpmiddelen (10 a 20% van de onderhoudskost)

7. Laboratorium en QC kosten

8. Patenten en royalties

Vaste kosten bestaan uit:

1. Afschrijving

2. Locale belasting

3. Verzekering

4. Werkruimte kost

5. Intrest op investering

De kost van onderdelen is afhankelijk van de oorsprong van de onderdelen:

• Onderdelen aangeschaft van verkopers.

• Onderdelen in-huis ontwikkeld en gefabriceerd door onderaannemers.

• Onderdelen in-huis geproduceerd.

Onafhankelijk van de bron van de onderdelen is de kost ook afhankelijk van
enkele andere factoren. Voor gefreesde onderdelen zijn volgende vragen be-
langrijk voor het bepalen van de kost:

1. Wat is het materiaal waaruit gefreesd wordt?

2. Welk type freesmachine wordt er gebruikt (aantal vrijheidsgraden)?

3. Wat zijn de dimensies van het onderdeel?

4. Hoeveel te frezen oppervlakken zijn er, hoeveel materiaal moet er weggenomen
worden?

5. Hoeveel onderdelen moeten er gemaakt worden?

6. Wat is de tolerantie en de afwerkingsgraad (zie Tabel 4.8)?

7. Wat is de arbeidskost voor personeel.
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Tolerantie Afwerking Productiekost
1. Fijn Gemiddeld 11.03€

2. Nominaal Gemiddeld 8.83€

3. Ruw Gemiddeld 7.36€

4. Fijn Gepolijst 14.85€

5. Fijn Gedraaid 8.17€

6. Carbon staal 22.45€

Tabel 4.8: Effect van de tolerantie en afwerking op de kost

4.3 Value engineering - Value analyse (VE -

VA)

Het doel van waardeanalyse WA (Eng.: value analysis) is het systematisch
elimineren van alle kosten die niet bijdragen tot de waarde van een product,
proces of dienst. Onder waarde wordt daarbij verstaan al datgene wat de
gebruiker ertoe brengt het product of de dienst te verlangen. Waarde-analyse
heeft altijd een dubbele betekenis: niet alleen analyseren, maar ook creëren.

Binnen een onderneming berust het succes van waardeanalyse op drie
pijlers:

1. De methode wordt door het management gewaardeerd en onder-steund.
Een waardeanalist is doorgaans een stafmedewerker of een consultant.

2. Een waardeanalyse-onderzoek vindt plaats in teamverband met verte-
genwoordigers uit verschillende disciplines binnen de onderneming.

3. Er wordt een duidelijk omschreven procedure doorlopen. Een Europese
norm bestaat nog niet; doorgaans wordt gewerkt volgens de Duitse
(DIN 69910) of de Franse norm (ISSN 0335- 3931).

Het doel van waardeanalyse (WA) is doorgaans kostenbesparing door een
eenvoudiger en goedkoper samengesteld product te ontwerpen. Door middel
van een analyse van de functies, gebaseerd op de eerste schetsen, en een voor-
lopige stuklijst, worden functiekosten in beeld gebracht. Wanneer een team
ontwerpers de methode consequent toepast, wordt de creativiteit geprikkeld
en ontstaan nieuwe concepten. Waardeanalyse is dus een methode om over-
tollige kosten in het productontwerp te elimineren. En dat is vaak nodig,
want een product is doorgaans te duur. Wat veroorzaakt nu die immer te
hoge kostprijs? Globaal kunnen we de volgende oorzaken aangeven:

• te hoge specificatie (meer leveren dan wat de klant/markt vraagt);
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• te snel een constructieprincipe kiezen (jumping to solutions);

• te weinig afstemming met bestaande artikelen (te veel varianten);

• te veel en te duur materiaal;

• te veel bewerkt oppervlak;

• te zware verbindingen (overdimensioneren uit overbodige veilig-heidsoverwegingen);

• te nauwkeurige toleranties en te fijne afwerking;

• te dure machines en gereedschappen.

Een ontwerper onder tijdsdruk construeert op te veel veiligheid en niet op
optimale kosten. De stelregel van WA is dan ook: Construeer niet zo goed
mogelijk, maar zo goed als nodig!

Bij een WA-onderzoek doorloopt het team achtereenvolgens de volgende
fasen (zie ook Figuur 4.8):

1. Opdrachtfase: bepalen taak, target, team, termijn.
De opdracht van het management aan de waardeanalist zou kunnen
luiden:

• ontwikkel door middel van WA van product X1 een variant X2 die
komende zes jaar geproduceerd gaat worden met een jaaraantal
van 8.000;

• realiseer een kostprijsreductie van 20%;

• haal specialisten in het team van inkoop, voorcalculatie, fabricage
en laboratorium;

• presenteer binnen vier weken een voorstel.

2. Informatiefase: vergaren specialistische informatie.
Als voorbereiding op een WA-onderzoek doet de waardeanalist het vol-
gende.

• hij verzamelt de eisen waaraan het ontwerp X2 moet voldoen, bij
voorkeur vertaald in de functies die het product moet verrichten;

• hij zorgt voor een tekening van het product X1 met stuklijst;

• hij stelt een concept-functieboom van product X1 op;

• hij plant een aantal sessies en roept het team bij elkaar met daarin
doorgaans calculators en specialisten uit de fabricagevoorbereid-
ing.
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3. Visualisatiefase: opstellen functieboom
Een functieboom wordt als volgt samengesteld:

• aan de hand van de stuklijst stelt men van elk stuknummer de
functie(s) vast (zie Figuur 4.9 voor het voorbeeld van een papier-
perforator);

• elke functie wordt op een kaartje geschreven en deze kaartjes of
gegomde briefjes worden op een groot bord geprikt of geplakt.

• de functies worden in kolommen gerangschikt: uiterst links de
hoofd-en nevenfunctie(s), daarnaast de afgeleide functies van het
eerste niveau, daarnaast die van het tweede niveau, enzovoort;

• in horizontale richting is er logische samenhang. De rechter func-
ties geven antwoord op de vraag: Hoe wordt deze functie vervuld?,
terwijl naar links kijkend de vraag beantwoord wordt: Waartoe
dient deze functie?

Een voorbeeld van een functieboom voor een perforator is weergegeven
in Figuur 4.10.

4. Analysefase: inventariseren functiekosten.
Als de functieboom klaar is, stellen we een functiekostenmatrix samen.
De horizontale as bevat de deelfuncties uit de meest rechtse kolom.
Verticaal staan alle onderdelen en bewerkingen die geld kosten. Als
niet precies bekend is wat de inkoop- of maakprijs is van stuknummers
of wat de kosten zijn van de bewerkingen, processen en assemblagehan-
delingen, moeten deze geschat worden.

5. Creatieve fase: ideengeneratie, brainstormtechnieken.
Voor elke (deel)functie zoeken we naar alternatieve oplossingen (met
behulp van de technieken uit Hoofdstuk 2). Wanneer het stadium van
ideeëngeneratie gepasseerd is, kan met behulp van een morfologische
kaart een geschikte combinatie gezocht worden (zie Figuur 4.12).

6. Evaluatiefase: keuze maken uit alternatieven.
In de evaluatiefase gaan we de verschillende alternatieven met elkaar
vergelijken en wegen. Twee dimensies spelen daarbij een doorslaggevende
rol: de functievervulling en de kostprijs. Wanneer nu veel alternatieven
voor een product bedacht zijn, zal in de performatie kost matrix (ook:
P -F -matrix) een puntenwolk voorkomen waardoorheen een verticale en
een horizontale criteriumlijn gezet kunnen worden, die de puntenwolk
in de volgende vier gebieden verdelen (zie voorbeeld in Figuur 4.13):
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(a) alternatieven die niet aan het kwaliteitscriterium Pq voldoen en
duurder zijn dan de targetprijs Ft vallen direct af;

(b) alternatieven onder de lijn Pq maar goedkoper dan Ft komen in
aanmerking voor verbeteringen;

(c) alternatieven die voldoen aan beide criteria worden nader uitgew-
erkt (de goedkoopste het eerst);

(d) alternatieven die kwalitatief goed zijn maar boven de kostprijs-
target uitkomen geven de meeste hoofdbrekens, zeker als er géén
oplossingen voorhanden zijn die aan beide criteria voldoen. De
verleiding is dan vaak groot om, onder druk van de tijd, toch
maar te kiezen voor de duurdere oplossing en de gestelde kostpri-
jstarget te negeren in plaats van de uitdaging aan te gaan om het
gestelde doel te realiseren.

7. Invoeringsfase: implementatie en resterende knelpunten.
De ervaring met waardeanalyseprojecten in binnen- en buitenland leert
dat het verwerkelijken van kostprijsbesparende ideen niet als vanzelf-
sprekend verloopt. Het gemakkelijkst wordt een WA-resultaat opgepikt
als binnen de organisatie een procedure voor nazorg bestaat. Veel grote
bedrijven kennen een technische commissie op hoog managementniveau
die regelmatig vergadert en dan knopen doorhakt ten aanzien van pro-
ductwijzigingen.
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Opdrachtformulieren
- Taakafbakening
- Target
- Termijn

Informatiefase
- Informatie verzamelen
- Functies indelen
- Functiekosten-matrix

Onderzoeksfase
- Nodige functies?
- Kosten bepalen

Creatieve fase
- Brainstormtechnieken
- Geen road-blocks

Evaluatiefase
- Ideeën uitwerken
- Selectie alternatieven
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- Beslissing management
- Nazorg

Is doel bereikt? Kan opdracht
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van opdracht
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Figuur 4.8: Flow-diagram WA volgens DIN 69910 (fase 3 en 4 zijn hier
samengetrokken tot ’Onderzoeksfase’).
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Onderwerp: Perforator
Planning : 180.000 stuks/jaar
Looptijd : 5 jaar

Stuknr. Onderdeel Mat. Loon Totaal
Fabricagekosten

Aantal

  1
  2
  3
  4
  5
  6
  7
  8
  9
10

1
1
1
2
2
2
1
2

1

Hefboom
Drukstang
Asje
Veer
Stempel
Fixeerschijf
Grondplaat
Geleider
Montage
Deksel

20
10
  5
  5
10
  6
20
40

30

10
  5
  5
25
15

  5
20
60

30
15
10
30
25
  6
25
60
60
30

Totaal 146 145 291

Figuur 4.9: Voorbeeld: perforator met stuklijst en kostprijs per stuknummer.
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Figuur 4.10: Voorbeeld van een functieboom van een papierperforator.
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Figuur 4.11: Functiekostenmatrix van een papierperforator.
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Figuur 4.12: Morfologische kaart olieleidingen.
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Figuur 4.13: Beoordelingsmatrix.



Bijlage C

Introductie MS Project

C.1 De fundamenten

 

Titel balk

Menu balk Invoerbalk

Taakinvoertabel 

Tijdsschaal 

Tool balk

View balk 
Balk tabel

Figuur C.1: Default MS Project openingsscherm (Gantt view).

1. Open het programma ’Microsoft Project’.

339
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2. In het default venster (zie Figuur C.1) kunnen volgende items gevonden
worden:

• Balk tabel: toont grafische taken informatie.

• View balk: toont het project in verschillende mogelijke zichten.

• Menu balk: toont de namen van de commando menus.

• Titel balk: toont de naam van de gebruikte file.

• Tool balk: shortcuts naar veelgebruikte commando’s.

• Invoer balk: toont de gegevens van een veld in de taakinvoertabel.

• Taakinvoertabel: toont de taken die ingevoerd zijn voor het project.
Verschillende zichten geven variaties in de taakinvoertabel (voor
sommige zichten is er geen taakinvoertabel).

• Tijdsschaal: toont de tijd in verschillende formaten.

3. Selecteer File → New in de menu balk.

4. Selecteer een Blank project of maak gebruik van één van de tem-
plates (New from template item in het New Project venster). Een
template is een type file die opgesteld is voor een bepaald type project
(zie voorbeelden in Figuur C.2).

5. De ’Project Guide Wizard’ kan gebruikt worden als gids doorheen de
verschillende stappen in het creëren van een project. Dit venster kan
getoond worden via: View → Toolbars → Project Guide.

6. Voer de project informatie in (start datum, eind datum, etc.): selecteer
Project → Project information (zie Figuur C.3).

7. Voer de werktijden in: selecteer Tools → Change working time.
Er kan ook een nieuwe kalender gedefinieerd worden in dit menu (zie
Figuur C.4).

8. Verander het tijdsschaal formaat: Format → Timescale.

9. Opslaan van het project: File → Save as. Er kan eveneens een ’base-
line’ opgeslaan worden (dit is een kopie van het project dat als refer-
entie wordt gebruikt doorheen het verloop van het project): Tools →

Tracking → Save Baseline.
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Figuur C.2: Menu voor het openen van een template.

C.2 Invoeren en schedulen van de taken lijst

1. Intypen van een taak naam in het taak naam veld.

2. Voer de taak duur in.

3. Creëer een ’Milestone’ door voor de taak duur ’0’ op te geven of door
’mark task as milestone’ aan te vinken in de ’Task Information’ dialog
box (zie Figuur C.5).

4. Door met de rechter muisknop op de ’Task ID’ (met het taak nr) te
klikken kan een taak verwijderd, ingevoegd of gecopieerd worden.

5. Regelmatig terugkerende taken kunnen ingevoegd worden via: Insert
→ Recurring task.

6. Met de ’indent’ en ’outdent’ iconen in de tool balk (zie C.6) kan de
hïrarchie van de taken gewijzigd worden (vb. van een taak en subtaak
maken).
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Figuur C.3: Menu voor het invoeren van de start- of einddatum en prioriteit.

 

Figuur C.4: Menu voor het veranderen van de werktijden.
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Figuur C.5: Menu voor het markeren van een taak als ’milestone’.

7. Het ’linken’ of ’unlinken’ van taken kan d.m.v. de iconen getoond in
Figuur C.7 (de volgorde van selecteren van de te linken taken geeft ook
de opeenvolging).

8. Naast het ’link’ icoon bevind zich het icoon

 

om een taak te ’splitten’
(onderbreken en op een latere datum verder laten lopen). Ga hiervoor
na het indrukken van het ’split’ icoon naar de Gantt balk en sleep van
de begin tot het einde van de pauze.

9. Door de dubbelklikken op de pijlen in de Gantt chart kan het type link
(FS, FF, SS of SF) aangegeven worden en kan een overlap (vul een
negatieve ’lag’ in) of een delay (positieve ’lag’) ingevoerd worden (zie
C.8).

10. In de ’advanced’ sectie van de Task Information kunnen verschillende
types taken geselecteerd worden: ’Fixed duration’, ’Fixed units’ en
’Fixed work’ waarbij: duration = work/assignment units. De ’effort
driven’ check box geeft aan of de effort of andere resources voorrang
krijgen in de scheduling (zie Figuur C.9). In hetzelfde venster kunnen
ook ’deadlines’ en ’constraints’ ingesteld worden en kan ook een andere
kalender gebruikt worden.
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Figuur C.6: Iconen voor het ’indenten’ en ’outdenten’ (omcirkeld).

C.3 Toewijzen van resources en kosten

1. Creëren van een ’Resource sheet’: selecteer View → Resource Sheet,
voer resources in en vul de respectievelijke velden in (zie vb. Figuur
C.10).

2. Invoeren van ’Resource availability’: selecteer de resource en click op
de ’Resource information’ knop.

3. Groeperen van resources: selecteer Project → Group by → Re-
source Group.

4. Veranderen van resource schedules: in de task view selecteer het ’Re-
sources’ blad van het Task Information window (zie C.11). Via een
drop-down lijst kan een resource gekozen worden. Het toewijzen van

resources wordt gedaan door op de

 

knop te drukken wanneer
een taak geselecteerd is.
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Figuur C.7: Iconen voor het ’linken’ en ’unlinken’ van taken (omcirkeld). 

Figuur C.8: Invoeren van de opeenvolging van de taken.

5. Om kosten voor de resources in te voeren met eerst de resource view
geselecteerd worden. Daarna kunnen de kosten ingevuld worden in
de ’Costs’ tab van het resource information window (zie Figuur C.12).
Voor het invoeren van vaste kosten: View → Table → Cost, en wijzig
de velden.
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Figuur C.9: Invoeren van het type van de taak.

C.4 Bekijken van de project database

1. Veelgebruikte views (in menu view): ’Gantt’, ’Calander’, ’Network dia-
gram’, ’Task usage’, of één van de tabellen (’cost’,’entry’, etc.). De ’crit-
ical path’ kan worden gevisualiseerd door ’Detail Gantt’ te selecteren
onder ’More Views’.

2. Een view kan worden geprint door: File→ Print.

C.5 Updaten van projecten en bekijken van

vooruitgang

1. Updaten van taken: Tools→ Tracking→ Update Tasks. Voer een
percentage van vervollediging in. Ofwel: View → Toolbars → Track-
ing.

2. Updaten van resources: View → Table → Work. Typ een andere
waarde in het het ’actual’ veld. Voor resources met ’Time Periods’
gebruik: Format → Details.

3. Updaten van kosten: selecteer View → Task Usage en daarna View
→ Table → Tracking. Voer de nieuwe kost in in het veld ’Act Cost’.
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4. Controle van de Tijdsduur Variantie: View → Table → Variance.

5. Controle van de Werk Variantie: View → Table → Work. Controleer
het variance veld.

6. Controle van de Kost Variantie: View → Table → Cost. Bekijk het
’Variance’ veld.

7. Bekijken van Project Statistieken: Project → Project Information.
Klik op de ’Statistics’ button.
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Figuur C.10: Invoeren van resources in de resource informatie (rechts).
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Figuur C.11: Schedulen van resources.

 

Figuur C.12: Invoeren van resource kosten.




